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Thoughts

®» First Presentation Together — In Person!

» \Weaving It all together — may or may not work but...

» We will have fun and you will leave with...
»Specific resources and treatment ideas

» We Apologize in Advance

» A Message from Our Missing Presenter
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Healthy Sexuality
Complex Topic Often Neglected

| ftle literature/research specific to healthy
sexuality and individuals who commit sexual
offenses (Watter & Hall, 2020)

»Developing healthy sexuality mentioned but few
specifics or resources

»No research related to navigating healthy
sexuality in the online world especially for
individuals who have committed sexual offenses

»Eqsier to "just say no”, however....

» Difficult tfo know who to allow access to online
sexuality, however....
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Forensic Sexology vs Human Sexology
(Miner, 2006)

Forensic sexology seeks to eliminate deviant sexudlity vs the
human sexology approach to understand sexuality of the client.

Forensic sexology requires polygraph testing because it assumes
that offenders cannot be frusted and will not be responsible.
Human sexology perspective assumes offenders can be
moftivated and treatment process can be trusted. Quality
intervention, not the polygraph helps increase public safety.

Forensic sexology emphasized treatment techniques.....numan
sexology emphases a quality therapeutic relationship.

Sexual Preoccupation, Deviant Sexuality, Healthy Sexuality
(Marshall et al., 2016)
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Watter & Hall, 2020

Sex offender freatment has become such a
specialized field from the larger world of
psychotherapy.

If healthy sexuality is a goal for sex offender
treatment this isolation has to change and
integration needs to occur.
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Watter & Hall

1. A frauma-informed approach to sex offender freatment would
help build the foundation necessary for healthy and pleasurable
sex. (researchgate.net/profile/jilllevenson),

2. A sex therapy approach incorporating concepts and
techniques from sex therapy offers a pathway to expand the
experience of sexual pleasure.

3. A forensic approach facilitates the maintenance of clear
boundaries and behavior.

4. An inclusive approach to sexuality, recognizing sexual
diversity. ***




10/26/2022

0000000000000

$000000000000000

>4 +9
R D
g

+4

++

S e

T —

95 ndsb.L B2+ 25, 5855
L0050 L @ ) cCOT .,
5283820825354 C0 58 5S¢
25558505 E52cE 28 HESsT
858528088550 cREEEgEs
PERPGOE" "S5 88 "EEEG

0 e

L B

+44

+44:

+44

++4

—— +44-

+44

+44

44

44

s
e L b e

Lale 2 2 e

-

R
-




10/26/2022

Gender ldentity
vs. Sexudal
Orientation

“... sexual orientation concerns who one
wishes to go to bed WITH, whilst gender
identity is who one goes to bed AS.”
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Domains

Emotional
Intimacy

Sexual

|dentity Attraction
/
(Expressed) Cultural/ i
Fantasies

Religious
/

Political

ldentity
(Internal)

Sexual

Behavior
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Traditional Gender Model

Sex Male Female
Gender Roles Masculine Feminine
Gender Identity Man Woman

J J

Sexual Orientation Women Men

1N
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{Tronsgender ]

* Gender assignment at birth is
inconsistent with gender identfity

[Cisgender ]

* Gender assignment at birth is
CONSISTENT with gender identity

(Affirmed gender

e Gender status post-transition

(Gender—offirming surgery

Gender confirmation surgery

11
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e )
Transman — FIM v.

fransmasculine

AN

\
e
Terms Transwoman — MTF

(Transgender) V. fransfeminine
\

AN

>
Drag Queen, Drag
kKing

19
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Social Acceptance (or lack thereof...)/Bias

» 'Homosexuals are child molesters”
» 'Homosexuality is perverse”

» “granting equal protection to same-sex acts would
open the door to combinations as three-party
marriages, incestuous marriages, child brides, and
other less-than desirable couplings.”

» “‘Gay Men are promiscuous”
» ‘| esbians don’t have sex”

» Not immune to gender stereotypes of Men vs. Women
(Boys vs. Girls).

12
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Who is / Do we consider a sex offender?

Medical Religion
"Science”

Societal Norms

11
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Gay men have significantly
more lifetime partners than
Partners heterosexual men and women
at all ages (Glick, et. al., 2012)

Multiple

1
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Open-Relationships/

Polyamory

» Common among gay men

» As psychologically healthy as
Monogamous couples

® | onger relationships

» Greater age difference between
partners

» Work best when tferms of the
relationship are defined

(Forssell, 2006)

1G
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Risk-
Taking
Behaviors

» High percentages of condomless sex
» Chemsex — pairing of sex and drugs

» Bathhouse Culture - Hook-Up apps

17
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Current

Research

» | GBTQ+ people appear to be
disproportionally charged and
more harshly punished than
their nonLGBTQ+ counterparts

» Where the age gap between
the parties is narrow, charges
for violations of age of consent
laws are much more likely to
be filed when the partners are
of the same sex (Kansas v.
Limon, 122 P.3d 22 (Kan. 2005))

» Prosecutorial discretion
influenced by unconscious
bias, polifics, societal pressures

1Q
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Lets Play — “Check My Attitude”

Masturbation Prostitution

Pre—Mar?ta|56).( o Adult Entertainment
Pre-Marital “Virginity

Extra-Marital Sex Sex Toys
Pornography Sex Games
Romance Novels Sex Clubs

Internet Sexuality Cross-Dressing
B/D-S/M Online Voyeurism/Online Exhibitionism
Non-Monogamy Same-Gender Sex
Role-Playing; Fantasies . .

Piercings Risk-Taking

Anal Sex Threesomes
Shave/Wax Pubic Area Fetishes

Makeup Sex Friends w/Benefits
Cosplay Post-Breakup Sex
Bestiality

Posting Sexual Pictures to Amateur Porn Sites

10
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We don’t want to pathologize sexuality that we don’t
adequately understand simply because it is...

condemned by
society,
the patient’s partner,
or even the patient,

or simply because we are uncomfortable with the behavior

"N
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» Your definition of healthy sexuality
» Offline/Online?

» The origins of your definition?

» Your openness to other definitionse
» | GBTQIA+

= Your knowledge of sexuality

» Your beliefs related to men and women

» Your sexual affiftudes and beliefs?

» Your model of sexualitye

» Your countertransference issues related to sexualitye
» Your level of comfort with your and other’s sexuality?

71
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Are You Qualified?

»Specialized training in sexuality

»Sexual Attitude Reassessment (SAR)
» ASSECT or SSSS Conference
» Courses/CEUs related to sexuality

» ASSECT colleagues for consultation/specialized
referrals

»Resources for Self/Clients
»\What's on your bookshelf related to sexuality

79
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SPRINGER PUBLISHING

THIRD EDITION

What Every

Mental Health
Professional Needs
to Know About Sex

Stephanie Buehler

712
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Books & Resources
» Arousal: The Secret Logic of Sexual Fantasies (Bader)

» Deviant Desires (Gates)

» Frofic Intelligence (Katehakis)

» New Male Sexuality (Zilbergeld)

» Perv: The Sexual Deviant in All of Us (Bering)

» Sexual Intelligence (Klein)

» The Guide To Getting it On (Joannides & Gross)

» Who's Been Sleeping In Your Head (Kahr)

» TransBodies, TransSelves (Erickson-Schroth)

» Rethinking Sex — (Christine Emba)

» Becoming a Kink Aware Therapist (Shahbaz & Chirinos)
» Creating Sexual Health in a Virtual World (Full Disclosure)

MN
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Resources

» hifps://www.lgbtgiahealtheducation.org/

» hitps://saigecounseling.org/

» hitps://www.thetrevorproject.org/

» hitps://www.lgbtcenters.org/LGBTCenters

» hitps://transequality.org/

» hitps://www.hrc.org/

» hitps://www.nami.org/Your-
Journey/ldentity-and-Cultural-
Dimensions/LGBTQ)M

» hitps://nicic.gov/lesbian-gay-bisexual-
tfransgender-and-intersex-offenders

» hitp://www.martyklein.com/

o 1~
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Attitudes Matters

» Sincere/Genuine

» Nonjudgmental/Non Shaming
» Curious/Open to Discussion

» Mutually Determined Goals

= Don't Ignore Ite

(Marshall, W. L., Serran, G. A., Fernandez, Y. M., Mulloy, R., Mann, R. E., & Thornton, D. (2003)

o 'y
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»Starfing with Healthy Sexuality
®»As many pieces as positive
»Creates a more positive treatment experience
®»Decreqgses resistance
» Creates awareness of the sex offense behavior
»Emphasizes health sexuality is important
»First group
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»Exploring...
»Knowledge of the Basics
®»Beliefs about Men and Women
»Sexual Attitudes/Beliefs & Values
»Past Sexual Experiences
»\ision of Healthy Sexuality
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OPERATION
TAKE & TALK

Butterflies in
Stomach

What makes you N
Nnervous/anxious N s\
when thinking
about sexuality?

2N
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Sexuality Continuum

Sexual Offense
Behavior

>
>

< >
Healthy Misuse Problematic Deviant

How do we decide?¢
We have different views
Our “glasses” affect our view of sexuality.

Figuring our your sexual soup

A Guide to Gender $5.00 Amazon (e-book)
Sam Killermann

21
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Sexual Interest Zones

Sexuality in your hot zone?
Sexuality in your warm zone?
Sexuality in your cool zone?

202
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The 13™ Witch

21
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Models of Sexual Health

» More than just feaching a model(s) to clients
 Weaving through all of therapy

« All behavior gets oriented around a model(s) of
sexual health

* The goal....
» Clients create their own vision of sexual health

20
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Models of Sexual Health
»Sexudl Health Model (u of M Program in Human Sexuality)

» CERTS Model (Wendy Maltz)
» Consent, Equality, Respect, Trust, and Safety

» Circles of Sexuality (Dennis Daley)

» Marty Klein

24



10/26/2022

Sexual Health Model
University of Mn Program in Human Sexuality

» Talking about Sex

» Culture and Sexual Identity

» Sexual Anatomy Functioning

» Sexual Health Care and Safer Sex
» Challenges

» Body Image

» Masturbation and Fantasy

» Positivity Sexuality

» [ntimacy and Relationships

» Spirituality

27
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Models of Sexual Health

»Sexudl Health Model

»\Neston Edwards, Ph.D
w»| ife, Liberty and the Pursuit of Sexual Health

»|iving a Life | Love: Healing SA, Sexual Compulsivity & Other
Sexual Concerns

»Cybersex Unplugged: Finding Sexual Health in an Electronic
World (Financial Interest)

20
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Models of Sexual Health

»CERTS Model (Wendy Maltz)

» Consent, Equality, Respect, Trust, Safety
»|t's All One Curriculum (www.popcouncil.org)




10/26/2022

Circles of Sexuality
Dr. Dennis Dailey

Sexualization

Flirting
Media Messages/Images
Seduction
Withholding Sex
Sexual Harassment
Incest
Rape

Boundaries

Sensuality

Skin Hunger
Aural/ Visual Stimuli
Sexual Response Cycle
Body Image
Fantasy

_ Intimacy
Caring
Sharing
Loving/Liking
Risk Taking
Vulnerability

VALU ES Self Disclosure

Trust

Sexual Health
& Reproduction

Sexual Behavior

Sexual Identity

Biological Gender
Gender ldentity

Anatomy & Physiology Gender Role

Sexual/Reproductive System

Sexual Orientation

Contraception/Abortion
STis

Healthy Youth Sexuality:

NN
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Sexuality: The Dialectic?

A Preference

Which Harms
No One

“Deviant Behavior”

Human Diversity Psychopathology

N1
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Sex Positive Cognitive Distortions

Non-Judgmental Manipulation

Evidence-Based Acting Out
Compartmentalization
Filers

Lh

/\

NN
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Framework for
evaluating
patients’
sexual behavior
& decision-
making:

« Honest?

« Consenting?

« Responsible?

« How do we define these?
 How does patient define these?¢

N2
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Ways to evaluate
sexual behavior &
decision-making

» Understand the risks?

* |s there someone they can tell?

« Enjoyable?

 Enlivening?

» Feel satisfied?

* Honest w/self¢

« Consonant w/ non-sexual valuese
» Sobere

« Shame-free?

NN
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HeCIIThy — Uncomplicated
sexudal
behavior s
n_OT O|WCIyS: — Free of unwanted consequences

— Internally conflict-free

NK
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We don't Sports

demg nd Home-owning
Th|S Of 0 ny Par.en’ring

Ther Going to school
O . . Shopping
OCTIVITy TV or film watching

Attending a conference
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Some people have heterosexual
monogamous intercourse—and they are
NOT emotionally healthy.

N7



10/26/2022

"Symptom"

Possible Explanation/Diagnosis

masturbation twice daily

sexually active

extramarital affairs

existential dilemma about aging or marriage

wants partner sex daily

sexually active;
possible personality disorder

enjoys s/m

desire for intense stimulation or bonding;
possible bipolar disorder

inappropriate come-ons

socially inept;
possible narcissism or asperger’s

exhibitionism

sexually active; possible OCD

wants non-monogamy

adventurous; possible borderline

straight, married, cruises public
bathrooms

conflicted about orientation;
committed to marriage

fetish behavior

self-aware; possible OCD

commercial sex

committed to marriage; social anxiety

internet pornography

sexually active; dissatisfied with partner sex;
Committed to marriage; possible depression

NQ
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What do |
see my
clients fore

Body Image Issues/Eating Disorders

Concern about HIV/STI exposure

Internalized Homophobia/Acceptance --- FEAR

Penis Size/Sexual Function

Coming Out

Relationship Issues/Dating

Identity - Masc vs. Femme; "Daddy Issues”

Substance Use

Isolation/Fitting in

Straight Crushes

Family

Intersectionality — Culture, Race, Religion, SES

Violence

Na
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Entering a
LGB
Community

Developing
a LGB
Intimacy
Status

Exiting a
Heterosexual
|dentity

Claiming an
Identity as
a LGB

Offspring

a
Personal
LGB

Identity

Developing a
LGB Social
Identity

=N
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Psychosexual
Development:
Beyond Freud

—  Awareness

— Seeking Information/Reaching Out

— Disclosure to Others

*Family
*Peers
*Others

—[ Exploration

N——

eIndividual
*eOthers

—[ Acceptance

—[ Integration

1
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Vision of Sexual Health

» \Will evolve over treatment/fluid document

» Will not be perfect

» Must be individualized to the client not to the therapist

» Ask clients to pull from are learning

» Obtain feedback from others

» A vision of sexual health can be used to address
®inappropriate, offense, sexuality

(8o ]
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Sexual Knowledge

»Sex Box (Questions)
»Clients can be in charge

» |5 to 20 Minutes Education Mini Session
» Clients Teach!

»Sex Jeopardy

g2
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Pornography Literacy

» Definition of Pornography

» Continuum of Adult Pornography
»Fducational Adult Pornography

»Treatment Option
»EFnhance Interest/Arousal o adult

oA
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Pornography Literacy

»Concept based on the belief that
®»Pornography can be anything!
» Many individuals will view adult pornography
» Clients need to understand the impact of pornography
»|nformed choice about pornography use

»\What doesn’t typically work...

» Just say no, you can’t do it, if you do look at porn,
efc......

|l g
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Board Overview of Research

» Research generally indicated that there is some association
between pornography consumption and deviant sexuadl
arousal, inappropriate attitudes, and subsequent antisocial
behavior, at least under certain conditions with certain
variables (Kingston, Malumuth et al., 2009)

» Simplistic to say it impacts all individuals in the same
way...instead research supports looking at interacting
variables (Kingston, Malumuth, et al., 2009)

| g
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Overview of Research
(Malamuth 2003; Malamuth el al., 2000; Shim et al., 2007)

»Personality Variables

» General Antisocial Characteristics/High Sexual Disposition/Hostile
Masculinity

»|nterpersonal Sex Orientation/ Perceived Rejection/Anger

»|ndividuals possessing these characteristics more likely to
seek out sexually explicit material and more negatively
iImpacted from the exposure.

g7
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Overview of Research
(Malamuth 2003; Malamuth el al., 2000; Shim et al., 2007)

»Environments
» Trusting vs Hostile Social Environments
» Conflictual vs Supportive Home Environments
»Delinquent vs Supportive Peer Environments

®»Some research to suggest that adult pornography
may “prime"” cognitive distortions such as women
are meant to be dominated and/or children want to
be sexual,

cQ
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Overview of Research

= Both high risk and low risk individuals were negatively
impacted by the use of deviant (child, violent, paraphilic )
pornography. (Kingston, et al., 2009)

» |ndividuals who view deviant (child, violent, paraphilic )
pornography are more likely to recidivate (Kingston, et.al.,
2008)

cQ
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Pornography Literacy

»|mpact of the Online World on Pornography Use
»Pornography Decision Matrix

®|celberg your Pornography

»Pornography Plan

» Understanding the Impact of Pornography
»Self and Others

aN
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Psychology of Technology

(

Cyber-hex

Delmonico and Griffin

*Easy to lose track of time, consequences, and real life relationships

*Form pseudo relationships — approximate reality without risk of emotional vulnerability and intimacy.

eInternet has become an integral part of life
ethe internet intoxicating and difficult to resist. Multiplied since the reward is sex.

¢

Online

Disinhibition

* Anonymity: You Don’t Know Me/You Can’t See Me
* Escape: See You Later

* Fantasy: It’s All in My Head

* Familiarity: We’re Equals / Friends

Suler

<

The E-Personality

*Narcissism: We are the center of the universe
*Shadow: Technology releases and nurtures
*Regression: Toward immaturity

*Impulsivity: Urge driven lifestyle

*Reinforced sensation seeking behavior

Adapted from
“Virtually You’ by Aboujaoude

Online
Objectification

* Distancing (Rimer, 2019)

* Detachment/Dissociation (Quayle et al.,2002; Rimer, 2019)
* Anonymity /Moral Flexibility

* Children are more like characters (Elliott et al.,2009)

* “Only Images” (Leonard, 2010; Winder et al.,2010)
*“Restricted view of harm” (Burke et al.,2002)

&1
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Pornography Literacy

»|mpact of the Online World on Pornography Use
»Pornography Decision Matrix

®|celberg your Pornography

»Pornography Plan

» Understanding the Impact of Pornography
»Self and Others

=39 ]
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Decision Matrix

To: Immediate Consequences Delayed Consequences
Positive 1 Negative 2 Positive 3 Negative 4
Look at
Pornogrpahy
Total Total Total Total
Positive 5 Negative 6 Positive 7 Negative 8
Not To;
Look At
Pornography
Total Total Total Total

Decision to Look at Pornography

Decision to Not Look at Pornography

[age }
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Pornography Literacy

»|mpact of the Online World on Pornography Use
»Pornography Decision Matrix

®|celberg your Pornography

»Pornography Plan

» Understanding the Impact of Pornography
»Self and Others

Iy |
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Adapted from
material by Virginia Satir

Fantasy

Feeling

What is my Belief/Schema?
What is the story in my head about this fantasy

What is my 7 Desire or Emotional Need
To be heard/To be understood
To be included/To be blessed/To be safe
To be chosen/To be affirmed

[y g
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(Developed by Deb and Mark Laaser)

7 Desires of the Heart‘

1. To be heard and understood.

2. To be affirmed.

3. To be blessed.

S
4. To be touched.
S

5. To be safe. J

T

[y g
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Pornography Literacy

»|mpact of the Online World on Pornography Use
»Pornography Decision Matrix

®|celberg your Pornography

»Pornography Plan

» Understanding the Impact of Pornography
»Self and Others

&7
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Pornography Literacy

»Nhttps://shop.mediaed.org/
»Pornland; How Pornography has Hijacked our Culture

»(QOver 18/The Price of Pleasure

»Documentaries on sexual attitudes/beliefs
» All have study guides

CQ
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Favorites

»Body Image
» Johari's Window
»Relationship Ladder (Geese Theatre Handbook)
» Healthy vs Abusive Relationships
»Force or Choice
»Short Videos
®»[ca Anyone
»The Genderbread Person

QA
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Name 3 things you like
about your body and why

Name 3 things you dislike
About your body and why

TN
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Favorites

»Body Image
» Johari's Window
»Relationship Ladder (Geese Theatre Handbook)
» Healthy vs Abusive Relationships
»Force or Choice
»Short Videos
®»[ca Anyone
»The Genderbread Person

71
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Open Self

Known to Self - “| know myself”
Known to Others - “They know me”

Information related to my sexuality that everyone knows

Blind Self

Unknown to Self - “l don’t know myself”
Known to Others— “They know me”

Information related to my sexuality that
people can find out or observe about me

Hidden Self

Known to Self— “I know myself”
Unknown to Others— “They don’t know me”

Sexual Secrets no one else knows about me

Unknown Self

Unknown to Self— "I don’t know myself”
Unknown to Others— “They don’t know me”

*Your unconscious or subconscious—dreams or mystical experiences

79
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Favorites

»Body Image
» Johari's Window
»Relationship Ladder (Geese Theatre Handbook)
» Healthy vs Abusive Relationships
»Force or Choice
»Short Videos
®»[ca Anyone
»The Genderbread Person

72
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Favorites

»Body Image
» Johari's Window
»Relationship Ladder (Geese Theatre Handbook)
» Healthy vs Abusive Relationships
»Force or Choice
»Short Videos
®»[ca Anyone
»The Genderbread Person

TN
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The Genderbread Person

g o~ Identity @ Gender Identity =
Genderqueer Man

Woman
Gender identity is how you, in your head, think about yourself. It's the chemistry that
compaoses you (e.g.. hormonal leveis) and how you interpret what that means.

- TN 2 . Gender Expression
~Orientation x P .
A Androgynous Masculine

Feminine
Gender expression is how you demonstrate your gender (based on traditional
gender roles) through the ways you act, dress, behave, and inleract

J Biological Sex -
Intersex Male

Female
Biological sex refers 10 the objectively measurable organs, hormones, and chromosomes

Female = vagina, ovaries, XX chromosomes: male = penis, testes, XY chromosomes:
inlersex = a combination of the two

@ Sexual Orientation .
Bisexual Homosexual

-
Heterosexual
Sexual orientation is who you are physically, spirituaily, and emotionally attracted to
based on their sex/gender in relation 0 your own

i~
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Sexual Health Plan (Ongoing)

» There is never a “final” version
®» Encourage clients to be creative
®» Presentation to group
» Questions/Comments/Suggestions
» Consider all feedback and make “tweaks”

» Provide a copy to your PO
» Otherse

TG



